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Installation Instructions and Cautions

PLEASE NOTE: SAGE 100 ERP must already beinstalled on
your system before installing any 11G enhancement. If not
already done, perform your SAGE 100 ERP installation and
setup now; then allow any updating to be accomplished
automatically.

Once SAGE 100 ERP installation and file updating is complete,
you may install your 11G enhancement product by following the
procedure below.

Wait! Before You Install - Do You Use CUSTOM OFFICE?
THIS IS AN IMPORTANT CAUTION: If you have
Custom Office installed, and if you have modified any
SAGE 100 ERP screens, you must run Customizer Update
after you do an enhancement installation.

But wait! BEFORE you run Customizer Update, it isvery
important that you print all of your tab lists. Running
Customizer Update will clear all Tab settings; your printed tab
list will help you to reset your Tabsin Customizer Update.
Custom Office isinstalled on your systemif thereisan
asterisk in thetitle bar of some of the screens. The asteri
indicates that the screen has been changed.

ﬂj * qales Order Entry (111) 06/12 /2006

Order Mumber Q\\: E,Bc:) @ @ @ @ I -----

1. Header I 2. Address ] 2. Lines I 4, Totalz

Order D ate ' Order Type
Custormer Mo M [ ‘
Ship To Addr
Tem: Code
Cloim Mimbm ) Chir Uiz

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

An asterisk in a
window’s title bar
indicates that the
screen has been
modified. This
means that
Custom Office is
installed.

Follow all the
instructions on
this page before
you run
Customizer
Update!
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Registering IIG products

I1G Enhancement should be registered to be able to useit.
If registration is not performed, the enhancement will work
in ademo mode for alimited time period. The registration
can be still done during the demo period.

Select the 11G Product Registration program under the
Library Master Setup menu of the SAGE 100 ERP.

If thisoption is not listed under the Library Master Setup
menu, go to the main menu, and select Run from the File
menu. Typein SVIIGR and click OK.

=eIIG Master Developer Enhancement Registration

Reaistered Customer G

~—HRegiztration Informatior

Reseller Mame

Serial Humber 1111111

Custorner Murmber 2L

J=zer Key 33333333333333333333

Product Key 5hE55 5hE55 5hE55 5hE55 5hE55
Enhancement Lewvel Feleaze Date  Senal Mumber Unlocking Fey
G Enhancement 5.00 ApppppAssAssAAS | BREBBE

Erhanc Lewvel

Fielease Date

Iz Enhancement 5.00

4]

Kl M= B

T

| o

[ Print Regiztration Form ]

|G| TST | B/24/2M3

Enter Serial Number and Unlocking Key provided by 11G,
and click OK.

If multiple I1G Enhancements are installed, Serial Numbers
and Unlocking Keys should be entered for each
enhancement.

Use the Print Registration Form button to print
I1G Registration Form.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Introduction

The RF Warehouse Automation enhancement for MAS
90 isthe tool you need to serve your customers more
effectively. Your team will be able to enter shipping data
and receipts of goods while on the road with their Radio
Frequency device with Windows CE — saving time and
ensuring accuracy.

By connecting salespeople who are in remote locations to
MAS 90 software, your company will bein a strategic
position to serve your customers more quickly and more
efficiently.

If you have salespeople who are traveling, Radio Frequency
solutions can be a valuable addition to your company.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Before you run RFS

Before you start using RF Warehouse Automation, you
must modify its desktop shortcut to be ableto runiit.

Map the Network drive where your Sage 100 ERP Standard
(MAS90) system is |located.

Right-click your MAS90 icon on the desktop, and select
the Properties in the pop-up menu. Go to the Shortcut tab.

In the Target field, type your

path\M A SO0\Home\pvxwin32.exe -hd ..\launcher\sota.ini
.\s0aRFS_Startup.mdp.

(where your path stays for the path to your Sage 100 ERP
system, e.g. D:\MAS\Mas500\RFS).

RFS 500 MAS 90 Properties x|

General  Shortcut |Eum|:uati|:ui|it_l,l| Sec:urit_l,ll

RFS 500 MAS 90
Ld

T arget type:

T arget location: Home

Target: Lt CRBREREVHFS startup.rmdp SASIEREETIN,

Stant ir: Id:\MAS\MAS S004AF54MAS504Home

Shartcut key: INune

Bun: I M ormal winidow j

Carmment: I

Find Target... | Change lcan... Advanced... |

aF. I Cancel | Apply |

Type the path to the Sage 100 ERP system using mapped
drive.Click Ok or Apply to save this change.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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RF Client Configuration for Sage100 Advanced ERP

To be able to run RF in the client server modeitis
necessary to copy the files from RFS_Workstation folder
to your Sagel00ERPWorkstation-> MAS90 folder. After
copying the filesit is necessary to create rfs_sota.ini filein
the: Sagel00ERPWorkstation\ MAS90 \Launcher. Itisa
copy of original sota.ini except that APPLICATION=
Sage 100 ERP RFS (thisis areference to an applicationin
the application server).

New Application called Sage 100 ERP RFS should be
added into the Application Server Configuration. Itisa
copy of Sage 100 ERP application with the following
changes:

Application Name: Sage 100 ERP RFS
Lead Program: rfs_startup.m4p

= Application Server Configuration

File Help

semver: | SAGE j Status: |Running (PID:248)

Sessinnsl Server l Clients ] Apps ] sers I Serice l Logging

=101 %]

Type | Deny | Application Name | Comrmand Line
L [T Sage 100 ERFP =arg(d)= -hd "StartUp. M4P"
L [T  Sage 100 ERF Link <arg(0)= -hd "SY _ProcessURL M4P"

-hd "RFS_StanUp M4P"

| <argD)>

MW |Sage 100 ERP RFS

l |

[ ] Ihelude Global Apps

(Dssie ) (bee_) (_oeina ] ooy ) (o)

INFORMATION INTEGRATION GROUP

877.475.4092
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¢ Current - App Props for Server: "SAGE" 5[
—Application —Options

App Name: | Sage 100 ERP RFS

ProvideX EXE: | <Default>

Sener [MI: |=:Defau|t:=

Lead Program: F.!FE: StartlUp. W4P

Extra CMD Options: |

Arguments: |

Start-In Directory: |<Defau|t>

Init Window: |Nurma|

&l

[ ] Disable Application
Allow Client Extra CMD Options
Allowe Client Argurments

Allowe Client to Set EID
[ ] Allow Client to Set Start-In Directory

—05 Level

—Clients

Client Type: |f-‘«ny Client Type

|

WindX Ver: Max WindX Ver:
Jawd Ver: Max Javid Ver:

Default Umask: 0000

[ ] Detach Spawns via Mohup

Additional Environment %ars:

=

The following changes should be done in the Sage 100

ERP 2013 shortcut to launch RF:

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM
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RF5_Sage 100 ERP 2013 Properties

General Sharteut | I:::umpatil:uilit_l,ll Seu:urit_l,ll

Sp
il

RFS_Sage 100 ERF 2013

2=

T arget bype: Application

T arget location: Haorme

T arget:

Alauncher /| FlRsE =N T R g4 R G | SERVER MAME" 10000 'S age 100 ERP RFS"

Start in:

I-:I: WA S AMAS BO0NS agehS age1 DOER P ork statio

Shortcut kew: IN-:une

Bur: I Marmal window j
Comment; I

Eind Target... | Change [con... Advanced... |

] I Cancel Apply

The path of your Workstation system is entered in the Start
infield. Therfs_sotaini and *rfs_Client are added in the

Target field.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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Sage 100 ERP for Windows CE Launcher

Note: The RF Warehouse Automation security event must
be enabled in the Role Maintenance for the role assigned to
the user in order to allow running Sage 100 ERP for
Windows CE.

sxE Role Maintenance (ABC) 2/14,/2014 - |EI|£|

Role ADMIN R VP NN

Dezcnption | Admin

1. Tazks 2. Securty Events| 3 Module Dptiu:uns] 4 SData Securit_l,l] 5 OCDBC Seu:urit_l,l-

+ Enable File Fun |
¥ Full Access to Private Reports for All Modules

¥ Full Access to Read Only Reports for All Modules

=] FF " arehouze Automation

# Matenal Requirements Planning

» Paperless Office

w Paproll

# Purchase Order

# Return Merchandize Authaonzation

# Sales Order

# TimeCard

& Wizual Integrator

o wfork Order =

[ Accept I Lancel I Delets lél@l

When running Sage 100 ERP for Windows CE, the first
screen you seeisthe User Logon screen:

=¥ Sage 100 ERP User Lo ed 4

o ‘:'
E nter your uzer logon name and pazsword.

User Logon ||

Paszword

[ oK, ]gan.:e| [@]

Enter your user logon and password.

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202
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Then select the Company:

EIpI=IES

Compary

ABC Distribution and Service Corp.

o ] e [O)

The launcher is opened:

~lcix

[ i+ Shipping Data Entoy
i@ iHecept of Goods E ot

i Irventary Tranzaction Enby

i+ Physical Count Entry

> B =

[ Procesd IﬁhutDDwnl

The MAS 90 for Win CE launcher enables you to work
with Shipping Data, Receipts of Goods, Inventory
Transaction (Transfer and Adjustment) and Physical Count.

To launch any of these options, select it and click the
Proceed button, or simply double-click the option you

want.

Y ou can aso change the active Company, Date, and User

clicking the icons below.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM
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12

2] (5

Select the company vou want to access.

Compary %

#re Manufacturing Company

——

=ESage 100 ERP Change { 21 x|

[z

Enter the accounting date for
Purchase Order.

Lo | oen [O)

The Shut Down button closes MAS 90 for Windows CE.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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Shipping Data Entry

If Batch Entry is allowed in the Sales Order Options, the

S/O Shipping Batch screen is displayed before opening the
Shipping Data Entry screen.

_(of x|

Batch Mo %E% 4 <4 @

Comment []
[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]

Statuz C. By

Entries 0| M. By

[ Accept I LCancel I Delete IG]

Click the Next Batch Number button to start a new batch,
or enter an existing batch number.

In this case, the batch number is displayed on the Shipping

Data Entry, and can be changed using the Batch Number
button.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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WWW.IIGSERVICES.COM



RF Warehouse Automation 5.00 14

= Shipping Data Entry (AR JYI=T)Y

D1 | &P A4s2014 70 Q
Shp oooo |5
| Batch Murnber, Alt-B |
/ o] = -
A N B B

[tern Code |Drdered|5hipped| Back |

1| | H|
OrEEEBOE2E

The Shipping Data Entry screen enables you to enter

shipping data.

s=eshipping Data En i I ] S
D1 | 2440201 T | ooooteD |G S

Shp 0100060 | Mew ooood <
M-RS5UFPPL R & 5 Supply Corp.

| C%_D_ o= =

o B Peglooot [0

|tem Code Drdered|5hipped| Back |
D400 1.00 0o qui]
D2000-C 1.00 0o qui]

4 | H|
| O |é Adne [ @

S/ID is Shipper ID.
is Clear. Next to it isthe Order No.

>~

Shipper 1D, Date, Order No, Lookups

First Lookup displays the Sales Order List, to ship the
selected Order. Second lists already entered Shipments.

Shp. isthe Shipping Number and Status.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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EIpI=IES

|1 || 214/201 |77 [ooonien (@ %

She 100060 | Mew | 000D1 ~  ###

01-RSSUPPL R &S Supply Corp.
Qa v . o % =
2B & Pkg/ooot [ [E]l

[kem E,:i Ttemn Packaging,l alk-G Ld| Back |

D400 1.00 1.00 .00
D2000-C 1.00  1.00 .00

1| | H|

Click the Item Packaging (Alt-G) button to open the Item

Packaging Maintenance.

Package (0001 | - % |4 4 B B

2B -
[tern on Order (v an Dr{ In Pkag |Dt_l,l it F'k;‘

_ 100 [ 1.00

D2000-C 1.00 [ 1.00

Accept l Cancel ] Delzte [ﬁ]

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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TP e
D1 |/ 2440200 T | ooooieo (S S
=hP 0100060 | Mew oooot | e

01-RSSUFPPL R &5 Supply Corp.

Qb o 2 % =
LI |
Mext Package Ma,, Alt-X Ibhipped| Back |
01400 1.00  1.00 o
Ce2000-C 1.00  1.00 o

“| | H|
| u ||5 Adne [ E]

Y ou can create the Next Package by the help of Next
Package No. button.

3 Do o
D1 |~ 24147201 57 | oooo143 |G, S
Shp 0100062 | New 0000t | HE

02-ALLEMNAF Allen's Appliance Fepair

% o 5 % >
2 & E Pkl 0001 [ &
lteny Lot/Serial Distribution, Al-¥ | Bagk = ||
1001-HOM-HZ54 | 25.00 I 25.00 I .0n
1001-HOM-H254L 300 300 .0n
2481-5-50 5.00

l |
o Ié Adlne[v]

The Lot/Serial Distribution button is enabled for
Lot/Seria lines.

The Lot/Serial Distribution screen is opened
automatically upon entering the Shipped Qty.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE

GLENDALE, CA 91202
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s | ot /Serial Number Dis 2 x|

[tern | 2480-8-50 DESK FILE 8" CaF 50

UM EACH| & El)

Lot N Show All Lets, A-L | Distribute)
et R 0000

4| | 3
Digtribution Balance R.O0

Auto Increment 5

A/lInc. is Auto Increment.
S displays the Shipping screen.

2| x|
Terms Code | 02 | 2% Ten Days, Met 30 Daps
Confirm Ta | Jeff Allen Q,
E-mail &ddr | JallenEavnet. com

Comment

Warehouse | 002 WEST WAREHOUSE

Shipia | MalL Q,

Ship Zone "

Ship Weight| 00448 |©, Pkgs 1
Fraht Ammnt .00

Tracking

The Tracking... button opens the Summary Package

Tracking Maintenance screen.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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=F Summary Package Trac ed
RE T

Flg | Trackil Itern Package Zoom, ALT-Z I—

0001

The A button on the Shipping Data Entry screen opens the
Ship To Address screen.

ShipTo | 3 QL Residential Add[]

M arne Allen's Appliance Fepair
Addrezz (18026 E. 10th
Rear Building

ZIP Code | 92875 State Ch,
City Fountain ' alley

Country

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
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Packing List Printing

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Packing List or
Both, the Packing List Printing screen is opened when
Accepting Shipping Entry.

Form Code | STAND: &
Dezcription
Copies 1 :II

Multi-Part Farm Enabled[ ]

Print Additional Packing Lists with Contents

Addl Form... | Print Comments | Partial - |

Charge Itemnsz []

b=gl
bdzg2

Adabe POF hd
[glignment] [ Frink IF"regiewI Setup @

Graphical Crystal printing is available.

If the Addit. Packing Lists box is checked; the
Additional Packing Lists screen is displayed after printing
(or previewing), allowing the user to print the additional
lists.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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sx¢ Additional Packing List ed
Form Code | STANDARD |G

Dezcription | Preprinted |

Copies 'Ilj Collated
Fulti-Part Form Enabled |:|

| #sdiobe PDF =|

[glignment] [ Etint ] Fresvigw lietupl & l

If the Automatically Print Shipping Documents box is
checked on the Main tab of the Shipping Setup Options
program under the Sales Order Setup menu, and the
Shipping Document to Print is set to Invoice or Both, the
S/O Invoice Printing screen is opened when Accepting
Shipping Entry, or after printing Packing List,
correspondingly.

S/0 Invoice Printing ed
Farm | STAMDA |% | Freprinted Lazer |

Copies Collated [v]

Multi-Part Form Enabled [ ]
Comments? m

| ddobe FDF =|

[glignmentl [ Erritit IPFEEiEWI Setup l@l

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202
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Receipt of Goods Entry

If Batch Entry is allowed in the Purchase Order Options,
the P/O Batch Number screen is displayed before opening

the Receipt of Goods Entry screen.

=Tk
Batch No Q14 4 b B
Camment ]

[Mn:ndif_u..l Werify Iﬂenumher.l Mgrge...]
Statuz C. By
Entrigz 0 k. By

[ Accept I LCancel I Delete l@]

Click the Next Batch Number button to start a new batch,

or enter an existing batch number.

In this case, the batch number is displayed on the Receipt
of Goods Entry, and can be changed using the Batch

Number button.

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
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20 o x
Rept Q[ Batch ooom )

Batches, alt-B [

' Date R

FO | " v No
Wend Mo, | | ! T

PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch, :
Terms :I 3
mn Usze Tax |:|

LH d b Bl [gcceptl Cancel I Delete ]

The Receipt of Goods Entry screen enables you to enter

and review receipts of goods.

Enter Receipt Number in the Rcpt No. field or click the #
(Next Number) button to create new receipt.

EIpI=IFS

Fopt

Batch |ﬁ|

Mext Receipt MHa,
Date

PO | " Inv.No

"-.J'enl:I.ND.l T o
PO St 1 Step
Purch. Addr. |:| - Required |:|_
ShpTo | |-
T#Sch. :
Terms :I 5
mﬂ se Tax |:|

Lﬂﬂ 4 b Bl [gcceptl Cancel I Delete l

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
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=¢Receipt of Goods

2| =10 ]

Ropt 001020 [ ° Bateh 000017

Date 2/14/2014 |57

Purch. Addr.

PO | 0070073 I, Mo
Yend Mo, | 01 -BH - N
|brin Carparation PO St | Mew

L Required | £/30/2 |77

Ship Te | 0000 C%.-‘-‘«BE CISTRIBUTIM
T/Sch. | DEFAULT % Default Tax Schedy
Temns |03 Ck HET EMC OF MOMTH

Uze Tax

L]

LW 4 b Bl [gcceptl Cancel I Delete l

Y ou can navigate through the orders using standard
navigation arrow buttons at the bottom of the screen.

TheH, A, L, T buttons open Header, Address, Lines,
Totals screens respectively. These screens correspond to
corresponding tabs of the Receipt of Goods Entry screenin

the standard MAS 90.

Here is the Header screen opened with the H button:

1099 Form | Mone =]
1099 Bax ﬂ

wihee EIE |G

Ship%ia | COMMOMN CARRIER
FOE
Comment
Confirn | JOHM STEVEMSOM
E-mail

Tel [415] B55-33E1

Ext

2l x|

INFORMATION INTEGRATION GROUP

457 PALM DRIVE
GLENDALE, CA 91202
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Click the A button to display the Purchase Address
screen:

=>Purchase address I E]

PEGT-IBE CORPORATION
Address | 33214 E. 46TH TERRACE

ZIP | 92775 State | CA

City | 54N FRANCISCO |
Country Ck

Phone | [415] 555-9381 | |
Fax

The Ship To button in this screen opens the Ship To
Address screen:

Mame |&BCDISTRIBUTING COMPANY
Address | 3131 AIRPORT LOOP

ZlF 92626 State | CA
City COSTA MESA

Country Ck

The L button on the Receipt of Goods Entry screen
displaysthe Lines screen:

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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sESage 100 ERP x|

@ Dopouwant bo receive the
\..‘:r) complete purchasze order?

Yes
. |oR 5|8 || & & -
LakiSerial Distribation, Alk-¥ =
== -{=5-

[tern Code Ordered |Heceived| it
GE-EQ380-10-04F| 10000 10000 18
GE-EQ380-10-MF|  B000 5000  1E
GE-EQ380-10-0F| 2500 2500 16
PFS-004-CABLE 250000 2.500.00

1.00 1.00 1107
a0 i

| | v
Tatal dmt | s26375 || ok |

If anitemis Lot/Serial, the Lot/Serial Distribution button
allows opening the Lot/Serial No. Distribution screen:

sxe | ot/ Serial Number Disk el

ltem | 2480850 | DESKFILE 8" CAP 50
U |Case| © =

Lat Mumber Showe &l Lats, 8k-L e

Q) . 00

Diistribution Balance 300

o)

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
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Enter the lot or serial number for the distribution, or click
the Lookup button to list all available lot numbersto be

distributed.

=F Lot /Serial N\umber Dis ed

[tern | 2480-8-50 DESK FILE 8" CaF 50

I | CASE J._ . ?2@ @ - E
Lat Hurmber | Aveailable | Distribute|

1 100.08

10210 200 |

JaM10 3.25

MaR10 8.80 jui]
0 0

Digtribution Balance .00

mar=e)

At the Distribute field, enter the total lot or serial number

amount to be distributed.

2] x|
;[ @ BEE
QU ETEER-

[tern Code Crdered |Heceived| =]
GE-EQ380-10-kF| 10000 100,00
GE-EQ320-10-F) 5000 50,00
GE-EQ380-10-F) 2500 2500
PFS-004-CABLE 250000 2.500.00

2420-3-50 2.00 200 1k

‘ I I nn nn _}I_I
Toatal At 823965 [ ][ ]| Ok

For Serial Itemsthe Select Serial Items button is available;

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202
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ltem | GB-MD731 | MODEM 9600 FAST POL
UM |EacH| S(E~ )

Sernial Humber -4 Add Serial Murnbers, Al-2

e | 0000

Digtribution Balance 1.00

mar=e)

Y ou can click the Select Serial Numbers button to select
the available serial numbers for the item or warehouse to be
distributed.

Y ou can also click the Add Serial Numbers button to
create new serial numbers for items that are being added
back to stock. The Add Serial Numbers task is available
only for serial items.

sxe Add Serial Mumbers ilil
[tem Code | GB-MD 731
Whae oo
Starting Serial Ma. | SERLALHO0|
[ ak. I Cancel I G l

It is necessary to enter only the Starting Serial No. and
sequential Serial numbers are automatically created based
on the Serial Item total quantity received.
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s | ot/ Serial Number Dis 2 x|

[term | GE-MDYS1 | MODEM 3600 FAST POL

IJsw | EACH % ' 5':'33 TG
Sernal Mumber | Aveailable | Distribute|
SERIAL#OO 0 IZI
0
Digtribution Balance .00

mar=e)

Y ou can aso add items on the fly.

Enter an item number that doesn’t exist in the Inventory

Management.

r@z:-|_D_H s\ @1 L -

Q == ={=Fy-
[tem Code Drdered|Heu:eived| IInit Cogt
1001-HOW-H29 500 ROD 34.280

2480-2-50 .00 300 545300
2568-3-25 200 200 575800
GE-D7A0 2.00 200 275850
MEW _ITEM 10 o0 onn

| | b
Tatal At 851045 [][]| Ok

When pressing Enter, the following message box will
appear asking whether or not to accept the new or Alias

Item.
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sESage 100 ERP x|

i Iz thiz a new [nventory [tem

Code?

Upon clicking Yes, the Item Maintenance screen will
appear for new item entry (Item number is the one entered
on the Lines tab of the Receipt of Goods Entry).

=F Item Maintenance ed

Item | MEW ITEM
Copy From | 1001-HON Q| [T (=

lLr-:u:I Ln ‘wha G WORKSTATION FURI
Fid T | Firished Goot ~|/Wal| FIFD =

P. Code STD QL Froc. Buy -

Wt GO DAY Ck B0 days from zhiprmer

)Stllst 35.750

StPr £7.000

PrUM [EAC Q, No.of EACH 1

Sls U/ EAC QL No.of EACH 1

Ftd I1¢m EACH Ck Image | abc_10 Lﬂ ‘

Y ou can use Copy from lookup button to copy the fields of
already existing items for the new one.

After filling in item related information in this screen and
clicking Accept, you will be returned to the Lines tab of

the Receipt of Goods Entry.
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2 x|

'“‘*a:-|_D.H 13|l FE -

QA ER-ER-

Itern Code Ordered |F|eu:ei~.-'eu:|| |~
GE-EQ380-10-F| 5000 50.00
GE-EQ380-10-F| 2500 2500
PFS-004-CABLE [2.500.00 2.500.00
GE-+D731 1.00 1.00 1.7
2480-3-50 300 300 1%

UEVCIEION ov | o o
J | o _>|_I

Total &mt 847115 [][]| Ok

For Alias Items (when you click Alias button on the
message box asking whether or not the entered itemisa
new item), the newly added Alias Item Number
Maintenance screen will be displayed.

= filias Item Maintenan

2l xi

Aliaz lkem Mo

ME W

Type | Wendor =
Yendor | 07-|BM

Item Mo [ 1001 -HOM-H252LE,

[tem Description
HOM 2 DRAWER LETTER FLE '/ LCE

Aliaz Item Description

&lias of 1001-HOM

Upon clicking OK you will be returned to the Lines tab
with the selected Item No automatically loaded into the

Item Code field in the data entry.
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2|
¥ |mR 7B| B -

QA EHxH-E-
[tem Code Ordered |F|eu:ei~.-'eu:|| |~

GB-EQ38010-MF| 2500  25.00
PF5-004-CABLE [2500.00 2.500.00

GE-MD741 100 100 1;
2480-850 300 200 1
100THONH252Y 00 00

o 00—

-

o |

o
Tatal At 889965 [][]| OK

If the Job Cost (or Work Order) module is integrated with
Purchase Order, the fields related to Work Order become

availablein the lines grid:

2 x|
'%|QH 2| | B FE - '
Q EHR-ER-

[temn Code*ork I:Irder| Step | Tranz Ty
STESTIM| 0095015 0072 Outside Procs

BOARD-] 0095016 0010 Miscellansou

1 | »

Total &mt 285930 [][]| Ok

Enter the Work Order number representing the work order
to which you want to distribute the cost associated with the
line item. Click the Lookup button to list all work order

numbers.

Enter the Step number for the selected work order against
which you want to distribute the cost associated with the

INFORMATION INTEGRATION GROUP
457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM



RF Warehouse Automation 5.00

32

line item. Click the Lookup button to list all step numbers
for the current work order.

Select a Transaction Type to be used to record the cost of
thelineitem. Thisfield isavailable only if awork order
number or step number was entered

Click the T button on the Receipt of Goods Entry screen
to display the Totals screen:

T axable Purchases a0
Maontaxable Purchases 8.675.45
Freight Amoint | .00
Sales Tax Amount .00
Irwaoice Tatal 2.675.45
Prepayment &xvailable .00
Frepayment Applied .00
Prepaid Check Mumber

Hold Paprnent []

[I__anl:led I:Dst...| Tay Detail... l
| Add Totals | 0K |

N/Tax. stands for Non-Taxable,
S/Tax for Sales Tax,

P/Pmnt Prepayment,

and P/Paid for Prepaid.

Hld Pmnt stands for Hold Payment.

The Landed Cost button opens the Landed Cost Entry
screen:
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e T
ok T_I,Ip{:u:rip|1eth Arnount |
FRGHT Frei 25.00
2 0

Total Landed Cost Z5.00

[ k. l LCancel L

The Add. Totals... button in the Totals screen opens the
Totals Additional screen:

T axable Purchazes 0
Montaxable Purchazes 8,839 E5
Freight &mount |00
Sales Tax Amount 0
Invoice Total 8,859 E5
Prepayment &yvailable .00
Frepayment &pplied a0

Prepaid Check Murmber

L]
O]

Hald Payment

[I__andeu:l Eu:ust...| T ax Detail... l
| 4dd Totals | OK |
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2 x|
Y |er| B | BfE -

QA EFH-ES -
[tem Caode Ordered |Heceived| | =

GE-EQ3S0-10-MF) 2500  25.00
PFS-004-CABLE (2500.00 2.500.00

GE-MD 791 100 100 1
2450-8-50) 100 300 1f ++NEW++ and ++AUTO++

1001-HON-H & 00 00
| .00

I [R—
4 I L
Tatal At 8.899.65 | I Ok

RFS Receipt of Goods works with bar code scanners.

If the New box is checked, the program will add itemsin
new lines irrespective of their presence in the existing lines.

If the Auto Increment box is cleared, the program will find
line with this item and select that line. Y ou can increase the
quantity in the line manually.

If the Auto Increment box is checked, the program will
automatically increase the quantity of the item in the line
where the received quantity does not exceed the ordered. A
new line will be added only if there is no such line.

Y ou can either check these boxes with the mouse or type in
++NEW++ or ++AUTO++ respectively in the Item

Number field.
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|nventory Transaction Entry

The Inventory Transaction Entry screen allows entering
Transactions of the Transfer and Adjustment types.

= Transaction Entry { 0] x|

Tranzaction Type | Transfers ﬂ
Entry Murmber % E’?p

Tranzaction Date

Tranzfer From "Warehouse

Transfer To %W arehouze
Comrment

Linesz

4 4 F K [ECDEPt I Eancell Qeletel

Select Transfers in the Transaction Type drop-down list
and click the Next Entry Number button.
Enter the Transfer Date, Transfer From and To

Warehouses, and Comment.

EIpI=ES

Tranzaction Type | Transfers |
Enty Mumber 00000005 - [

Tranzaction Date | 2/14/2014 :
Tranzfer From Warehouze | 000 Ck
CEMTRAL WAREHOLUSE

Tranzfer ToWarehouse ooz Ck

WEST wWaREHOUSE
Comrment

Lines

4 4 @ W [ECDEPt I Eancell Qeletel
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Y ou can navigate through the Transactions using standard
navigation arrow buttons at the bottom of the screen.
Click the Lines button to open the Transaction Lines
screen.

% |oR i [ =zl
EEiEsE N
[tem Code To'whae |

4. 1 | 2480-8-B0 002 9, | DES
2

Select an Item or its General Alias. The To Warehouse is
defaulted from the header and may be changed for
particular line. Enter the Quantity to be transferred, and
click OK.

If theitem is Lot/Serial, the Lot/Serial Distribution screen
IS popup.
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ltern | 2480-850 | DESK FILE &' CAP 5O
UM [EACH T 5 Bz
fwalable | Distibute |
ﬁ 10,002.00 300
L —
3 325,00 00
4 550,00 00
5 00 00
A [
Digtribution Balance .00
o O

Enter Lot(Serial) Number, and quantity to Distribute.
The List button opensthe list of all the Lot(Seria)
numbers. Use the & button to distribute all the quantity to a

selected Lot Number.

Select Adjustments in the Transaction Type drop-down
list and click the Next Entry Number button.
Enter the Transaction Date, Default Warehouse, and

Comment.

sae Transaction Enkr

Trangaction Type | Adjustments

Entry Hurmber 0000t o

2/14/2014

Tranzachon Date
Drefault ‘W arehouze Qoo
CEMTRAL wWaREHOUSE

Comment

Lines

2l =101 %]
O

E

a

14 4 b bi [2eospt] Cancel| Deere |
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Click the Lines button to open the Transaction Lines

screen.

sxF Transaction Lines

2 x|

% ;[ )| @1

E%-ER-

[tem Code

| (luantity

2 | 24580-5-50
3

imm HONH2E2 18, |

2.00
3.00
.00

4

o)

For items with LIFO/FIFO Va uation, the distribution
screen is displayed on entering the quantity.

sxe Distribution Enktry

2l xi

Item | 1001-HON-H252

Idnit of kMeazure | EACH

FIFDO Drate

Receipt Mo, | GO07T007

Avallable 10.00

Digtribute 200

7

Distribution Balance

00|

For items with Lot/Serial Valuation, the distribution screen
is displayed on entering the quantity.

INFORMATION INTEGRATION GROUP

457 PALM DRIVE
GLENDALE, CA 91202

877.475.4092
WWW.IIGSERVICES.COM



RF Warehouse Automation 5.00

39

Item  2480-8-50 |
Idrit af Meazure | EACH
Lot Murnber

JAN10 =

Ayailable 325.00

Diistribute [ 200
Digtribution Balance | .00 |
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Physical Count Entry

In the Role Maintenance select the RFS Physical Count
Entry task added to the Inventory Management
Miscellaneous Tasks menu to enable accessto RFS
Physical Count Entry for the current role.

= Role Maintenance {ABC) 9/8/2014

Role Admin SNV RPN

Description | Admin

1. Tasks 2. Security Eventz| 3. Module Dptinns] 4 SData Seu:urit_l,l] 5 ODBC Seu:urit_l,l-

= & Miscelaneous Tazks :I
& Automatic Cost and Price Change

B alarize Quantity On Hand

Beqginning Balance Recalculation for deverage Cost [kems

Correct Short IM1 Records

Delete and Change [tems

[/M Setup 'Wizard

[tern % aluation Change M aintenance

[tem % aluation Change Selection

Purge Item Hiztory

R ecalculate [tem Higtay

R emove Zero Quantity Costing Tiers

RFS Phyzical Count Entmy j

AR EAREAERRERA R

[ Accept l Cancel I Delete ldEblGl

On the Physical Count Entry screen, enter the Warehouse
Code, and select if you wish to see all lines frozen or just
the lines you will enter.
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x
| |rFs Physical Count Er
Warehouze Ck[
CEMNTRAL wWAREHOLUSE

Shaow Only Mew Lines

Y ou can navigate through the Warehouses using standard
navigation arrow buttons at the bottom of the screen.

Physical Count Entry requires that products be frozen
using the Physical Count Worksheet program similar to
how the standard Physical Count Entry program works.
However you normally only see what you counted to speed
counting and reduce errors in counting.

Click the Lines button to open the Physical Count Lines
screen.

There are two versions of the line screens. Thefirst screen
isthe standard screen if the MBN moduleis not installed or
activated for the selected warehouse. Thisis Item Code
Only screen. Counts are by Item only.

The second version of the screeniswhen [1G's MBN
moduleisinstalled and is active for the selected warehouse.
Thisisthe Bin/ltem screen. Counts are by Bin Location
and ltem..
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x
Iterm Code || |%
Bin Loc. | |
Ok
Item Code | Laot/Ser ... | Counted |
e ]
Item Code Only screen.
The Lookup button opens the Item List screen.
2l =10l x|
|tem Caode i
DRAWE
1007T-HOM-H252LE HO DRAMWE|__
1001-HOM-H254 HOM 4 DRAWEI
1001-HOM-H 254K, HOM 4 DRAMWEI
2480-83-R0 DESE FILE 8"
2481-5-50 DESE FILE 51/
2851-3-50 DESKE FILE 31/,
2863-3-25 DESK FILE 31/,
4396-18-14-3 PAPER CaADDY
BEA0-2E6-16-11 SOUMD CVR 26
BERZ-28-24-15 SOUMD CVR 28
GRS PRIMTER STAM
GERY-24-20-12 SOUMD CWR 24
3353 IMMERSAL 317
1| | 9
leIt...“j Search [ ViEWSlﬁelect]Eancell
|F|:|ur'u:| A rec | | |
Item Bin Location will be displayed for the selected item.
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x
Item Code | 1001-HON-H252 (=N

BinLoc. [E-300-10 |

ok

Item Caode | Lat/Ser ... | I:n:nunted|
1001-HOM-H252 5.00

P

If the Incr. box is cleared, the program will find the item
and select that line. Y ou can increase the count manually.
If the Auto Increment box is checked, the program will
automatically count up the item just after entering/scanning
the Item Number.

Y ou can enter/select the Item number or it's General Alias.

If the I1G UPC moduleisinstalled scanning the item’s
UPC code or the ITF-14 case code will select theitem. If
the ITF-14 case code is scanned the program will increment
by the standard UOM conversion factor. Soif the ITF-14
isfor example a case of 12 and the standard UOM is
EACH, the program will count 12 instead of 1. Thisis best
used with the Incr. field checked.

If the selected Itemis Lot/Serial, all the Lots (Serials) of
the item are listed.
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Select alot item from the Item List.
x|

Itern Cade | 2430-8-50 (=N
BinLos. |C-10010

JAMN10

Item Code | Laot/Ser ... | I:::uunted|
1001-HOM-H252 5.00
2480-8-50 JAMT0 1.00

.

Enter lot number in the Lot Number field and click Enter.
If the entered Lot Number existsin thelist it will be
selected, otherwise new Lot Number will be added in the

list. The lookup will show you the lots for the selected
warehouse.

x
Itern Cade | 2430-8-50 (=N
BinLoc. [C-100-10 |

Lovser o0&, [ |
Count
Item Code | Laot/Ser ... | I:::uunted|

1001-HOM-H252 5.00
2480-8-50 JaN10 1.00

.

If the Incr. box is cleared, the Lot number with a0 count
will not be added. Y ou must inter the count manually.
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If the Auto Increment box is checked, the program will
automatically increase the count of thelot.

Enter ++Auto++ in the Item Code field and press Enter to
check/uncheck the Auto Incr. box automatically.

Physical Count with MBN

Bin Loc. || |% [ Clear ]
[tern I:|:u:|e| | A
ok |

| Counted | L

£

H

Covint

Bin Loz | [tem Code

1| | |
s ] Forp il

When MBN isinstalled and the warehouse is enabled for
bin locations, the Physical Count Lines screen changes to
the Bin Location/Lines format.

Y ou must select the bin you are counting. An additional
check box (Keep Bin) will retain the Bin Location selected
and flow the scanning back to the Item Code to speed
scanning and counting of the products in the bin. When
you finish counting the bin, click on the Clear button to
reset the bin. Y ou can select by lookup or by scanning the
binif the binis bar coded.

Note: We suggest that you click Accept at the end of each
aisle to update the counts entered. Remember that nothing
is posted to the MAS count files until Accept is clicked.
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Lookupsin RFS

Lookups in the RFS enhancement enable all the
functionality the standard MAS 90 lookups have (except
for the Zoom button). The starting symbols can be entered
before clicking the Lookup button to narrow the displayed

itemslist.

sxe Jten List

|tem Caode

1001-HOM-H 2 ARedn]=t
1001-HOMN-H282LK HOM 2 DRAWE

1001-HOM-H254

1001-HOMN-H254LK

2420-8-50
2481-5-50
2551-3-50
2068-3-25
4886-158-14-3
BERO-2E-16-11
BE5Z2-258-24-15
BES5
BEG/-24-20-12
2353

4

|F_i|t... [] Search[] "v"iewsl Select |Eancel

HON 4 DRAWEI
HON 4 DRAWEI
DESKE FILE 8" C.
DESK FILE 51/
DESE FILE 31/
DESE FILE 314
PAPER CADDY
SOUMD CVR 26
SOUMD CVR 28
PRIMTER STAN
SOUMD CVR 24

UMIWERSAL 31T
F

| Found 80 rec |

TheFilt... button enables setting Filters.

2 =10] x|

Colurmn

| Operand | Yalue |

1 [tzm En:u:lej Beqing il 248

HE B
E B

Save Fiters [ ]
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After applying thefilters, the Filt... button appears red.

|term Cod

2 1
2431-5-50

1] | i
[Fjlt...] [] Search[ ] ViEWSl Select |Eancel
|F|:|ur'u:| 2 rect | | |

Check the Search box to specify search criteriain the
displayed fields. Click Find to search with the entered

criteria.

=z item ist el [l
|tem Caode i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DRAWE
1001-HOM-H252LE. HOM 2 DR&WE]
1001-HOM-H254 HOM 4 DR&WE]
1001-HOMN-H254LE. HOM 4 DRAWEI
2480-8-50 DESE FILE 8"
2481580 DESEFILER 14
2551-3-60 DESK FILE 314
28R8-3-25 DESE FILE 314
4386-18-14-3 PAPER CADDY =
4 I I ]
Itern Code || Begins with hd

20

Find
Filt... Search| | | Select |Eancel

|F|:|ur'u:| a0 rec | | |

Check the Views box to work with lookup views.

Select aview from the View drop-down box to switch to

that view.
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25
|tem Code i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DR&WE
1001-HOM-H252LE. HOM 2 DRAWEI
1001-HOM-H254 HOM 4 DRAWEI
1001-HOM-H254LE. HOM 4 DRAWE]
2480-8-50 DESKE FILE 8"
2481580 DESE FILER 14
2501-3-60 DESE FILE 314
2A68-3-25 DESE FILE 314
4886-18-14-3 FAFER CADDY =
1 | | 3
st Standard ﬂ
brief
|Fj|t... [ ] "v"iEWS| Select |§ancel

|F|:|ur'u:| 3 rec | | |

If thereis no custom view, the View drop-down box is not

visible.

EIJMIaTEY
|tem Caode i | D'ezcription ﬂ
1001-HOM-H252 HOM 2 DRAWE
1001-HOM-H252LE. HOM 2 DR&WE]
1001-HOM-H254 HOM 4 DR&WE]
1001-HOMN-H254LE. HOM 4 DRAWEI
2480-8-50 DESE FILE 8"
2481580 DESEFILER 14
2551-3-60 DESK FILE 314
28R8-3-25 DESE FILE 314

4886158143 PAPER E.-'-‘-.DD_YILI
4 I I 4

m D | Select |§ancel

| Found 80 rec | | |

Click Cust... button to create a new or change an existing

view.
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=F Lookup Customization ed

Select view parameters for Lookup.
Company ABC, Uzer G

Wiew | Create new wiew ﬂ|

D ezcription | Brief |

[ Delete l l Mest » l I LCancel l

=F Lookup Customization ed

Select or modify the colurmls).
Company &BC, Uzer IG Yiew - Brief

Available Fields Selected Columnz
ﬂ B * |tem Code
. ExtendedD Description
StandardUnitCost
- zelndR
. @ WarrantyCode
- JzelnS0
TarClazs
- JzelnPO
- zelnBh
- CaloulatelCr
- DropShip @
... FRMF nahle~
P |
[NewFisid..| 7= |{= ][ bodiv. |

(@) [ <Back [ text> J[ Einish |
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2]l

Heading |
Yafidth

Juztific:ation

Mask L HEE A HHO00-

Caleul field | &1

ok LCancel

= Calculated Field Bui e P ]

| |

nnaann

Available Fields

Itemlmage'w'inﬂ
- ItemimagsHe
i StandardUritl

- StandardUrni
- LastTotalUnit »

[ﬂ] [ ok ] [Eancell
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[F Lookup Customizatio ed
Enter ar modify the filkerlz].
Company &BC, Uzer IG Yiew - Brief

Calurnn

1
2

[ 44

1| | *
[ < Back |[ Wewt> ][ Einish |
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Appendix
An example of RFSInstallation on handheld devices

1-Microsoft Active Sync should be installed on the computer:

1-Download:
http://www.microsoft.com/downloads/details.aspx?FamilylD=7269173A-28BF-
4CAC-A682-58D3233EFB4C&displaylang=en
(If thislink didn’t work easily open www.google.com and search for “Download
Microsoft Active Sync”)
2-Click on Run

File Download - Security Warning

Do you want to run or save this file?

|—m MHame: setup.exe
Type: Application, 6,93ME

From: download.microsoft,com

Run J [ Save ] [ Cancel

i | While files from the Intermet can be uzeful, thiz file twpe can
I L’j potentially harm your computer. [F pou do not truzst the source, do not
= run or gave this software. What's the rigk?

3-On Welcome Page Click Next
4-Accept License Agreement and click next
5-Enter Customer Information and click next
6-Choose Destination folder and click next
7-Install...

8-Finish

2-After Installation of Microsoft Active Sync connect your PDA to the computer using
USB Cable and select Guest Partnership (No) and click next.
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Mew Partnership

Set Up a Partnership

Before vou can synchronize information between your
riobile device and thiz camputer, you must set up a
partnership between them.

Wiould you like to get up a partnership?

(O ves

Set up a partnerzhip so that | can synchronize
infarmation between my device and this comprker.

| don't weant bo synchronize infarmation. Set up my
device az a guest zo that | can copy or move
infarmation between my device and this complker.

< Back L_ﬂe:-cb ][ Cancel ] [ Help ]

3- In order to make connection between handheld device and Citrix server, Citrix ICA
client for windows CE hasto be installed on PDA:

1-Download Citrix ICA client for Windows CE on your computer:
http://www.citrix.com/site/SS/downloads/details.asp?dID=2755&download ID=3602
(If thislink didn’t work easily open www.google.com and search for “Citrix ICA client
for windows CE”)

2-Installation:
1-Run cesetup.exe
2-1t will ask for installation path:

Installing Applications El

Inskall "Cikrix Systems ICA Client” using the default application install directary

Cancel |

3-Click on “No” button
4-following screen will pop up:
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x|

Save In: b ain b emary j

kd ain b emary
| Platform
Space TE gLy
Space available.  er. TS .

k. I Cancel

Choose “Application” option from drop down list and click “OK” and follow the
installation on PDA screen to complete the installation. It will add two iconson PDA’s
Programs screen:

5-finish

4- Configuration of RFS on Handheld Device:
1-On handheld Device Click on Start then Programs
2-Choose ICA Client

l.;"_{.w'r ' Programs o3 oz 3216 9
Adr [ -
BEAM I
Games AirBEAM Calculator
Client

» [3

File Explorer ICA Client UT NN [T

Settings
wis
¥ & P
Microsoft SN Pictures

Reader Messenger —
% ¥ W

Pocket Excel Pocket MSN Pocket —
Word i

E|A
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3-Create New Connection

£ Internet Explorer  +F < 3:16 9

L)

bttp:ff127.0.0, 1fmain.htm -| @
E Main

Create Mew Connection
Pl Agent Properties
Edit Global Settings

| Connect | | Edit | | Delete
Bbout Citrix (8 Client For Mindows CE

view Tools ¢ £ (3 <% E|A

4-Enter the Citrix Server |P address

l.;'E;" Internet Explorer o =2 3:43 9

http:ff127.0.0.1fserver htmPvCreat - | @
E Main = Mew Connection > Server

Settings
Server or Published Application:
192,168,111.120

Refresh Servers
Refresh Published Applications
Server Locakion

| Save | |Eancel|

view Tools ¢ € o3 <% E|*
5-Save
6-Edit

877.475.4092
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7-Edit Application Settings

.,F.F Internet Explorer 4 =2 3:53 9

http:ff127.0.0.1fapplication.htrmay = | @

|E| Main = Edit 192,1658.111,120

Settings = Application Settings

Application:

Working Direckary:

| Save | |Eanl:el|

view Tools ¢ £ (3 <% E|A

8-1n this step you need to know the MAS 90/200 running address on Citrix Server. So,
Login to the CITRIX Server and Right-click on the MAS 90/200 program Shortcut and
select properties then write down the Address in Start-in path.

According to Shortcut address on Citrix Server fill the Application and working
Directory fields:

Application: your path\M A S90\Home\pvxwin32.exe -hd ..\launcher\sota.ini
.\s0a\RFS_Startup.mdp

Working Directory: your path\MAS90\Home

(Where your path stays for the path to your MAS 90/200 Start-in path, e.g.
D:\MAS\MasA50\Rfs).

10-Save
11-Click on Edit link and click on Edit Logon Information.
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*,frwj Internet Explorer  4F {2 4:10 9

http:ff127.0.0.1{login.htrm?vbame  « [ @

E Main = Edit 192.165.111.120

Settings = Logon Information

Username:

Password;

Darnain:

| Save | |Eanl:el|

Yiew Tools <@ @ < E|*

12-Enter your Citrix server logon Username, Password and Domain and saveit.

13-Click on “Edit <citrix server |P address> Settings’ link and click on “Edit Windows

Settings”

i i CAFRY
1 £ -
l.,Ej Internet Explorer o ={£ 4:14 9

http:ff127.0.0.1fwindow . htm?vMa - - | @

e
|z| Main

= Edit 197,168,111,120 Settings
= Window Settings (Absolute Size in
Pixels)

Window Colars:

Zhange ko Fit ko -
Screen

Inikial Display Scale Factor:

Initial Panning Position:
Ton | oft

Yiew Tools <3 ‘é T E|A

-

14- Click on “Changeto Fit to Screen” link and saveit.
15- Finish
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Sample
For the setup of Symbol MC9090 handhelds

AD Prep and Documentation

Allocate the handheld’s IP address, HH username, and hostname. Place adhesive labels
on the handheld using the format “HH<##f> <hostname> <IP address>".
Update info on the Handheld IP’s Excel Spreadsheet.

Initial Handheld Setup

1. Immediately place the unit in the charger to ensure the backup battery becomes fully
charged. Once the handheld is charged, proceed to the next step, removing the
handheld from the charging unit. (Charging will be more rapid if the handheld unit
remains powered off.)

2. Click on the Start button and set the system time.

3. Enter the hostname of the handheld and its description.

e Go to Start > Settings > System tab > About > Device ID tab > Device name:

e (In the Description field, input the HH user who will be using the handheld.)

e Click OK to exit.

4. From the main screen, disable 802.11d wireless access by using the Wireless Options
tool.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Regulatory”, then clear the “Enable
802.11d"” checkbox.

e Click Save to save changes, then Exit.

5. For P3 handhelds only — Enable both 2.4 GHz and 5.0 GHz bands for wireless
connectivity.

e Select the wireless icon on the lower right of the screen, and then select Options
from the pop-up menu.

e From the drop-down menu, select “Band Selection” and ensure that both “2.4
GHZ Band” and “5 GHz Band” are selected.

e Click Save to save changes, then Exit.

6. Connect the handheld to your company wireless network

e Select the wireless icon on the lower right of the screen, and then select “Find
WLANSs" from the pop-up menu.

e Once the scan for WLANSs has finished, select and hold your stylus over the
“yournetworkname” WLAN, then select Connect to initiate the connection
wizard. Enter the following settings:

0 Profile ID — accept both defaults, which should be “yournetworkname”.
Click Next to continue.

0 Operating Mode — accept both defaults, which should be
“Infrastructure” and “Allow Any Country”. Click Next.
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7.

0 Authentication — accept default “none”. Click Next.

0 Encryption — use the drop-down menu to select “40-Bit WEP”. Accept
the default Key Index of 1 and leave the “Use Passkey” checkbox
unchecked. Click Next.

O 40-Bit WEP —replace the password fields with 10 lowercase a’s: aaaaa
aaaaa. Click Next.

O IP Address Entry — Use the drop-down menu to change the option to
“Static”. Click Next. Enter the IP Address and Subnet Mask, then check
the Advanced check box. Click Next. Leave the G/W field blank, enter
DNS server info, and leave the WINS field blank. Click Next.

0 On all remaining screens, accept all defaults. You will then be back at
the Manage Profiles screen. Click OK to exit.

0 If you are prompted with a pop up box that says “Establishing
Connection”, choose the “Work” connection.

0 On the lower right corner of your screen, you should see your wireless
status indicator either in red, yellow, or green, indicating the strength of
your wireless signal.

Test connectivity to your LAN.
e Click on the wireless status icon in the lower right corner of your screen and
select “Wireless Diagnostics” from the popup menu.
e Select ICMP Ping.
e Inthe IP field, enter 172.16.1.1, and click on Start Test.
e Monitor the Total Tx and Total Rx indicators to ensure you are able to ping the
company gateway.

Installing The Datawedge Application

1.

Place the handheld in a charger and connect the charger via a USB cable to a computer
that has Microsoft ActiveSync installed.
Upon your computer’s registering the connected mobile device, navigate through the
Active Sync wizard, indicating that there is nothing you want to synchronize. If your
system does not connect to the handheld, try adjust the “USB to PC” setting on the
handheld. By default the “Enable advanced network functionality” checkbox is checked.
You should uncheck it if you experience any connectivity issues.
e Go to Start > Settings > Connections tab > USB to PC
Go to your computer, and select the “Explore PocketPC” option from the Tools menu of
Active Sync. This will open an Explorer window into your handheld.
Copy the appropriate Datawedge components, as excerpted below from Symbol’s
documentation:
e Unzip the DataWedge download package (if necessary) into a temporary folder
on the PC.
e Copy “\Bin\PPC\DataWedge.exe” from the PC to the \Application folder on the
device.
e Copy “\Application\DataWedge.cpy” from your PC to the \Application folder on
the device.
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8.
9.

Browse to the \Application\Bin\PPC\DataWedge.exe file, hold the stylus on the file until
the popup menu appears, and select Copy.

Paste the shortcut into the Windows\Startup folder on the handheld. (If you cannot see
the Windows folder, you may need to enable the option to unhide hidden and system
files on your computer.) Then manually launch Datawedge by selecting it while you are
still in the \Windows\Startup folder.

Click on the DataWedge icon in the lower right corner of your screen, and from the
popup menus, go to Barcode > Prefix/Suffix.

Check the checkbox that says “Send ENTER key after suffix”

Click OK to exit.

10. Test the scanner by opening Word Mobile and performing a test scan.

e Go to Start > Programs > Word Mobile

e Click on New to create a new document if no other test document is available.

e Scan a barcode and observe the data in Word Mobile. Each successive scan
should be on its own line.

e Exit until you get the handheld’s main screen.

Installing the Citrix ICA Client

1.

From your computer make sure that the handheld has been able to reconnect to your
computer, and run the Citrix CE client program, cesetup.exe. Click OK when prompted.
Your computer will now display a message stating that you should check the handheld
for any further messages to finish this installation. Click OK and proceed to your
handheld...

Your handheld should now be asking you a location to which you want to install the
Citrix client. Accept the default, which should be “Device”, then click “Install” on the
lower left corner of your screen.

Click on “I Accept” to accept the license agreement.

After the program installs, you will receive a confirmation message that installation was
successful. Click OK to exit.

Warm boot the handheld to verify that DataWedge loads on startup.

Disconnect the handheld from the cradle and terminate your Active Sync session, as
wireless access may be disabled while connected to Active Sync.

Connection Settings For Wireless Citrix Environment

1.

vk wnN

Open the Citrix ICA client configuration utility.

e Go to Start > Programs > ICA Client
From the main menu, select PN Agent Properties.
Select “Enable PN Agent”.
In the Server URL field, enter the IP address 172.16.1.195, then click on the Save button.
If the connection is made, you will be presented with a Login Details screen. Enter the
below details:

e Username: the HH<##> ID of the handheld.

e Password: the default password.

e Domain: “your domain name”

INFORMATION INTEGRATION GROUP 877.475.4092
457 PALM DRIVE WWW.IIGSERVICES.COM
GLENDALE, CA 91202



RF Warehouse Automation 5.00 61

Check the “Save Password” checkbox, and then click OK.

When the screen refreshes, scroll down and click on the Save button one more time.
At the top of that screen, click on the “Main” hyperlink.

Click on Edit Global Settings.

. Click on Edit Preferences.

. Scroll down to the “Enable Full Screen (No Local Taskbar)” checkbox, and check it.

. Scroll to the bottom of the screen, and click Save.

. Click the X to exit.

. You should now be at the Programs Screen. Click the X to exit to the Main screen of the

handheld.

Setting up a Connection to MAS

1.

A

Notes

1.

Configure the appropriate menu settings.

e Go to Start > Settings > Personal tab > Menus

Scroll down the Menus page until you see the “T200” icon, and select it. Click OK to exit.
The T200 icon should now appear on the Start Menu.

Click on the T200 icon to initiate a connection to MAS.

Enter the appropriate User ID and corresponding password.

If this is the first time you have connected to MAS using this handheld, MAS will prompt
you for the company code you wish to access. Enter the Company Code and select OK.
You should now be at the MAS 90 for Win CE main menu. Select Shut Down to exit
MAS. You will be returned to the handheld’s main screen.

In the event that the handheld is cold booted, most (if not all) of the setup steps will
need to be repeated. A warm boot will cause no loss of settings.

When resetting after a cold boot, make sure to rename the handheld to the
appropriate hostname BEFORE configuring the Citrix environment. This will aid
in not causing duplicate terminal server licenses from being issues to the same
handheld. Also make sure the handheld is not connected to Active Sync.
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